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Integrating DWF Printing into 
your Océ Repro Desk workflow 
The Design Web Format™ from Autodesk is becoming a popular print-ready 
format for distributing files to anyone who needs to view, review or print them. 
For reprographers, printing DWF™ files may be challenging because many 
print software applications and printer controllers do not yet support DWF files 
natively. This document is intended to provide reprographers with the 
recommended method for printing DWF files with Océ Repro Desk® Server. 

What is DWF? 
DWF is an open, secure file format developed by Autodesk for the efficient distribution and 
communication of rich design data to anyone who needs to view, review, or print it. DWF files have the 
print-ready and size benefits sought by reprographers, in addition to the workflow and metadata 
features sought by end-users. DWF files are highly compressed, so they are smaller and faster to 
transmit than design files, without the overhead associated with typical CAD drawings (or the 
management of external links and dependencies). With DWF, publishers of design data can select the 
specific design data and plot styles they want recipients to see and can publish multi-sheet drawing sets 
from multiple DWG source files in a single DWF file with a single click. DWF files are not a replacement 
for native CAD formats such as DWG—designers still need the original files for editing or updating 
design data. However, DWF enables designers, engineers, developers, and their colleagues to publish 
rich design information and intent to anyone who 
needs it. You can view and print DWF files with the 
free, lightweight Autodesk® DWF™ Viewer, you can 
create DWF files from non-Autodesk applications with 
the free Autodesk® DWF™ Writer, and you view, 
print, measure, mark up, track changes and integrate 
reviews with Autodesk® DWF™ Composer or Volo® 
View.  See page 8 for links to product information.  

Printing DWF Files 

There are several methods for printing DWF files: 

1) Using the free Autodesk® DWF™ Viewer to print to a standard Microsoft Windows® printer queue. 
This method is not recommended for production reprographics since high-volume Océ printers are 
rarely managed by a Microsoft Windows® printer queue.  This method is most appropriate for on-
site facilities-managed Océ printers, low-volume Océ printers, and other printers that are available 
via a Microsoft Windows® print queue. 
 

2) By converting the DWF into an alternate supported format. In this method users open DWF files in 
the Autodesk DWF Viewer and then create plot files one at a time using HPGL print drivers. This is 
a cumbersome and time-consuming process that provides unpredictable results. A slightly 
improved version of this process is to use the Autodesk DWF Viewer to print all the DWF pages in 
one step to a capture-and-convert utility such as Adobe’s® PDF Writer®. While not recommended, 
this method may be employed when a specific file format is desired. 

 

Autodesk and Océ Partnership 
In September 2003 Océ announced an 
agreement with Autodesk to support DWF. 
Under this agreement, Océ will natively 
support DWF within Océ's range of printing 
solutions for the technical document market. 
Océ has completed the first step of this 
process and delivered native DWF support 
into the Océ Publisher product. 
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3) The most effective method for printing DWF files in a commercial reprographic setting is to use a 
combination of two applications: Océ Repro Desk (Server or Remote) and Océ Publisher. This 
method allows a user to assemble a list of DWF files, each of which can contain multiple sheets, 
and batch-process these files. The user can adjust image properties, predetermine output options, 
add stamps and overlays, preview files exactly as they will print, and print them out via Océ Repro 
Desk Server. The print-ready job can also be saved for future reprinting. 

About Océ Publisher 
Océ Publisher is one of several Océ Client Tools, a set of print preparation and submission utilities that 
can be downloaded free. Océ Publisher has a built-in DWF rasterization engine developed by Océ in 
partnership with Autodesk. This allows the utility to batch-process DWF files into LDF files, which are 
supported by Océ Repro Desk. See page 8 for links to product information.

Configuring Océ Repro Desk Server to Receive Jobs from Océ Publisher 
Two procedures are required in order to complete this set-up. The first step is to run a configuration 
utility on the Océ Repro Desk Server PC (requires Admin rights). Instructions: 

1) On the Océ Repro Desk Server PC, load the 
Océ Repro Desk Server 1.6 CD.  

2) Navigate to the Tools directory, open the 
RDClientToolsConfig folder, and run the 
Setup file.  

3) Follow the InstallShield instructions and 
select “Run Repro Desk Client Tools 
Configuration.” 

4) The Client Tools Configuration dialog and 
the Help dialog appear. Print and follow the 
Help instructions. 

5) Once you have completed the Client Tools 
Configuration and clicked Apply, proceed to 
the Océ Client Tools PC. 

 

Setting Up an Océ Repro Desk 
Destination in Océ Publisher 
The second step required in order to complete this set-up is to add a new destination to the Select 
Destination dialog in Océ Publisher. Both the client and server PC must be on the same network. 

1) On the Océ Client Tools PC, open Océ Publisher and add a file. 

2) Click the Océ Print button to open the Select Destination dialog. 

3) Highlight the Add Destination icon and click the Select button. 

4) Choose Océ Repro Desk Server Queue and click OK. 

5) Enter the path to the Océ Client 
Tools Setup file and click OK 
(click Help if necessary). 

6) The new Océ Repro Desk Server 
destination icon will appear on 
the Océ Publisher Select 
Destination dialog.  
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Using Océ Publisher – Step 1: Add Files 

Set preferences in Océ Publisher by selecting Options from the Tools menu (options described below). 
Once configured, click the Add Files toolbar button and select the DWF files you wish to print. Below is 
the Océ Publisher user interface with the AutoCAD “8th floor” sample DWF file containing six sheets.  

 
 
DWF Options 

• Banded Memory Size: This determines how much memory in megabytes to use for DWF 
processing. 10 MB is recommended. Other values may dramatically slow processing speed. 

• Default Dither Method: The following Dither options are available: 
o Not Dithered – This is the fastest processing method, but doesn’t support embedded 

raster images or represent color geometry. 
o Simple Dither – This method approximates colors with grayscales. This method is 

slightly faster than Error Diffusion. This setting will work well for most DWF files. 
o Error Diffusion – This method approximates colors with grayscales. This method often 

yields better results than Simple Dither. This is the default and recommended setting. 
o All Black Geometry – This method renders all geometry in black. Images are normally 

not affected. This method may be appropriate when the author created a DWF file 
with color lines and wants to print black-and-white. This setting allows you to force 
faint or colored geometry to print in full black. 

• Add All Pages: Selecting this option allows you to process all sheets contained in a DWF file. 
• Minimum Line Width: This setting is available in Océ Publisher 1.6.2+ only and determines the 

minimum width at which a line will be printed. It keeps extremely thin lines from disappearing 
entirely when drawings are reduced. A minimum line width of 4 pixels is recommended. 
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Step 2: Process Files 
After adding files to Océ Publisher and setting your preferred options, click the Process toolbar button. 
In the image below, Océ Publisher contains the 8th Floor DWF sheets processed into LDF files. DWF 
sheets may take up to a minute each to process depending on file size and processor speed. The 
resulting LDF files contain a thumbnail image that appears in the lower right corner of Océ Publisher. 
Properties can be edited directly in the job window or in the Properties panel to the right. 

 
 
 
 
Step 3: Preview Files 
For a print preview, double-click a sheet name or select the View toolbar button. The View dialog will 
appear. The Océ Publisher viewer provides a true WYSIWYP (What You See Is What You Print) image 
of the document. All sheets should be previewed in detail so the user knows exactly what the printing 
results will be. 
 
Stamps and overlays can be added to LDF files by choosing Add Stamp / Overlay from the File menu. 
Each layer appears in the lower right corner of the viewer, allowing individual overlays to be 
manipulated. Stamps can be saved for future use and can be modified by choosing Stamp Editor from 
the Tools menu. 
 
If any changes are made to the document properties after they have been processed, they will need to 
be re-processed before printing. 
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Step 4: Print Files 
Once you are satisfied that all drawings are ready to print, click the Océ Print toolbar button. The Select 
Destination dialog will appear. Select the appropriate Océ Repro Desk printer icon and click the Select 
button. The Océ Print work order dialog will appear. 

 
Complete the fields in the Océ 
Print dialog. Océ Repro Desk will 
send these instructions to the 
printer. This data will also be 
logged by Océ Repro Desk 
Server for accounting purposes. 
 
Océ Repro Desk Server will 
receive and process this job in 
the same way it handles jobs 
from Océ Repro Desk Remote. 
 
Before closing Océ Publisher, 
you are given the option to save 
the entire job for future printing. 
The job is saved as a .dxp file 
(Digital eXchange Package). 
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Configuring Océ Repro Desk Server to Support DWF Files 

Océ Repro Desk (Server or Remote) has an advanced configuration feature that allows it to utilize an 
external file interpreter to convert specific file types. Océ Client Tools contains a “MakeLDF” utility that 
can be used in this manner to convert DWF files. Océ Repro Desk 1.6.3 or newer and Océ Client Tools 
1.6.3 or newer must both be installed on the same PC to enable this functionality. 

Configuration Instructions 
1. In Windows Explorer, create a 

directory where the MakeLDF 
utility will write files to (for example, 
create C:\ocerd\MakeLDF). 

2. In Océ Repro Desk, click 
Advanced from the Configure 
menu. 

3. Expand the File Processing 
branch. 

4. Expand the DWF branch. 
5. Click the Preprocess Target 

Directory branch and enter the full 
path to the directory you created in 
Step 1. 

6. Click the Preprocess Command 
branch and enter the following 
command line: 
        makeldf "%f" /D=”%d” 

7. Click OK in the Configuration 
Manager dialog and restart Océ 
Repro Desk. 

Test DWF File Processing 
1. Add a DWF file to an Océ Repro 

Desk Server job. 

2. Click the Process toolbar button 
and wait for processing to 
complete. 

3. If successful, the filename will 
retain its DWF extension and the 
DWF icon next to the filename will 
be replaced by the LDF icon.  

If DWF processing fails, view the About option on the Help menu of both Océ Repro Desk and Océ 
Publisher to make sure you are using version 1.6.3 or newer. Also, be sure the Preprocess Command is 
typed correctly with the %f contained within quotation marks. 

Additional Information 
Users of Océ Repro Desk Server who have valid maintenance contracts are eligible to receive the 1.6.x 
updates. However, they may not receive specific updates automatically and should therefore contact 
their Océ dealer or sales representative to request the latest Océ Repro Desk Server 1.6.x CD. 

The configuration instructions above can be applied to both Océ Repro Desk Server and Océ Repro 
Desk Remote. This allows DWF conversion to be performed by either the end-user or the print operator. 

Further technical information is available in the Release Notes on the Océ Repro Desk Server CD.
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DWF Printing – Questions & Answers 

 
Q. What software do I need in order to batch-print DWF files? 
A. In a reprographic environment, Océ Repro Desk Server 1.6.3 and Océ Publisher 1.6.3 or newer. Océ 
Repro Desk Server can be obtained from your local Océ dealer or sales representative. Océ Publisher 
is part of Océ Client Tools, which can be downloaded free. See page 8 for links to product information. 

In a Microsoft Windows print queue setting, the free Autodesk DWF Viewer can be used to print all the 
pages of a DWF in one step using the print dialog and selecting “All pages.” 

Q. Are there any other ways to print DWF files? 
A. Yes. The Autodesk DWF Viewer and Volo View can both print DWF files. However, these options 
may require plot file drivers that can generate unpredictable results and can only print one file at a time.  

Q. I’m still using Océ Repro Desk version 4.30. Can I print DWF files? 
A. Yes. Océ Repro Desk 4.30 does not support print jobs sent directly from Océ Publisher. However, 
Océ Repro Desk 4.30 does support LDF files. Use Océ Publisher to process DWF files and then choose 
the print-to-file option to save the LDF files to a local directory. You can add these LDF files to an Océ 
Repro Desk 4.30 print job. 

Q. What’s the best way to convert DWF files to TIFF files? 
A. Process the DWF files in Océ Publisher and then print them to TIFF using the Group IV Out (9400) 
TIFF driver option in Océ Repro Desk Server. However, you should reconsider using TIFF files as a 
standard business practice. Formats such as DWF, LDF and PDF are rich in data unlike TIFF, and can 
be much more effective for project management and archiving. 

Q. Will Océ Repro Desk support native DWF files someday? 
A. Yes. Océ will deliver native DWF support in three stages: 

1) Océ Client Tools 1.6.3 contains a “MakeLDF” utility that converts DWF files to LDF files. Océ 
Repro Desk can be configured to point to this utility to process DWF files (in the same way 
Ghostscript is used to process PDF files). This way DWF files can be added to an Océ Repro 
Desk job like any other supported file format. See Page 6 for instructions. 

2) Océ will release a major new version of Océ Repro Desk in 2005. This version will allow a user 
to add native DWF files to an Océ Repro Desk job. 

3) Océ is now working to integrate native DWF support directly into the TDS printer controllers. 
However, a release date has not yet been scheduled. 
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Product Information 

Océ Repro Desk:  www.oce.com/en/Software/ReproDesk/default.htm 

Océ Client Tools:  www.reprodesk.com/info/download.asp 

Autodesk DWF:  www.autodesk.com/dwf 

Autodesk DWF Viewer:  www.autodesk.com/dwfviewer 

Autodesk DWF Composer:  www.autodesk.com/dwfcomposer 
 

About Autodesk 
Autodesk is the world's leading design software and digital content company, offering customers 
progressive business solutions through powerful technology products and services. Autodesk helps 
customers in the building, manufacturing, infrastructure, digital media, and wireless data services fields 
increase the value of their digital design data and improve efficiencies across their entire project 
lifecycle management processes. For more information about the company, see www.autodesk.com. 
 

About Océ 
Océ is a leading provider of digital document management technology and services. The company’s 
solutions are based on Océ’s advanced software applications that deliver documents and data over 
internal networks and the Internet to printing devices and archives – locally and around the world. 
Supporting the workflow solutions are Océ digital printers and scanners, considered the most reliable 
and productive in the world. Océ also offers a wide range of display graphics, consulting and 
outsourcing solutions.  
 
Netherlands-based Océ N.V. (NASDAQ: OCENY), with a workforce of more than 22,000 people and 
2003 revenues of $3.0 billion, maintains research and manufacturing centers in the Netherlands, the 
United States, Germany, France, Belgium, the Czech Republic, and Japan. Océ’s North American 
headquarters is located in Chicago with major business units in Chicago; New York City; Boca Raton, 
FL; San Jose, CA; Salt Lake City; and Coventry, RI. North American revenues were $1.2 billion for 
fiscal 2003, and employment is currently 9,100. For more information about Océ, visit 
www.oceusa.com. Outside the U.S., consult www.oce.com. 
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